
Introduction to Acowin Payroll 
 
 
I. ............................................................ 1 Configuring QuickBooks for Acowin Payroll
II. ................................................................................................. 4 Acowin Payroll Setup
III. ....................................................................................................... 5 Payroll Linking
IV. ................................................................................................... 7 Payroll Processing
V. ........................................................................ 9 Synchronizing Payroll to QuickBooks
VI. ........................................................................................... 10 Employee Time Cards
 
 
This document will show you how to configure the Acowin Payroll system, introduced in 
Acowin version 4.7, and use it to process your weekly payroll.  The hours totaled by the 
Acowin Payroll system are sent to QuickBooks, where they appear as weekly time sheets.  
Note that Acowin Payroll is processed weekly.  If your technicians are paid biweekly, 
you will need to process Acowin Payroll one week at a time. 
 

I. Configuring QuickBooks for Acowin Payroll 
 
In order to use the Acowin Payroll system, you’ll need to make sure a few things are set 
properly in QuickBooks. 
 
1. You must switch QuickBooks into Single-User Mode to complete the following steps.  
To accomplish this, make sure all other users are logged out of QuickBooks.  If the 
Acowin License Manager is connected to QuickBooks, restore it to full-screen mode and 
click the Break From QB button.  After this is done, pull down the File menu in 
QuickBooks, and click Switch To Single-User Mode. 
 
2. In QuickBooks, pull down the Edit menu and choose Preferences.  Click on the Time 
& Expenses icon, then select the Company Preferences tab. 
 
3. The Time & Expenses screen is pictured below.  Be sure to select YES for the answer 
to Do you track time?  Also, use the pull-down menu to set the First Day of Work 
Week.  This should be the same day you will choose on the Acowin Payroll Setup screen. 
 



 
 
4. Select the Payroll & Employees icon on the Preferences screen, and accept the offer 
to save the changes you made to the Time & Expenses screen.   
 
5. Choose the Company Preferences tab of Payroll & Employees.  On this screen, which 
is pictured below, be sure to select the Full Payroll option.  Under the Job Costing, 
Class and Item Tracking heading, choose the option to assign one class per Earnings 
Item.  This is very important, because Acowin will send over different Classes based on 
the Distribution Codes used with each Call Slip.  Click OK to save your changes and 
close the Permissions window when done.   
 

 
 



6. You can now return to Multi-User Mode in QuickBooks.  This is done by pulling down 
the File menu and clicking Switch to Multi-User Mode.  You can reconnect the Acowin 
License Manager to QuickBooks when this is done, and allow other users to log into 
QuickBooks. 
 
7. Open the QuickBooks Employee Center.  Double-click on the first employee who 
works as a technician, and will therefore receive hours from Acowin Payroll.  (Note that 
you don’t have to perform the following procedure for every Employee – just the ones 
who work on Call Slips in Acowin.) 
 
8. The Edit Employee screen will appear.  Pull down the Change Tabs menu at the top 
of the screen, and select Payroll and Compensation Info.  This causes the screen to 
change to the layout pictured below. 
 

 
 
9. On the Payroll and Compensation Info screen, check off the option called Use Time 
Data To Create Paychecks.  Also, be sure the correct Earnings items, hourly rates, and 
Deductions are present.  You should have set up the Earnings and Deductions when you 
configured QuickBooks payroll, of course.  Click OK to save your changes when done. 
 
10. Repeat steps 7, 8, and 9 for each employee that will receive Payroll hours from 
Acowin.  You should then be ready to proceed with Acowin Payroll Setup.  Be sure you 
have switched QuickBooks back into Multi-User Mode and reconnected the Acowin 
License Manager! 
 



II. Acowin Payroll Setup 
 
To set up the Acowin Payroll system, open Accounting Setup, then click the QB Payroll 
Setup button, pictured above.  You’ll find this button in the bottom right corner of the 
Accounting Setup menu. 
 
The Payroll Setup menu is very simple.  You only need to Enable Payroll Sync, select a 
few options for dealing with overtime pay, and indicate which day of the week begins 
your weekly payroll period.  You will then be ready to move on to the Linking tab, where 
you will link your Acowin Employees to their QuickBooks counterparts.  The Payroll 
Setup screen is pictured below: 
 

 
 
Click the Enable Payroll Sync button to activate the link between Acowin and 
QuickBooks Payroll.  After you click the button, a message will appear, informing you 
that you have successfully activated Payroll and can proceed to the Linking screen when 
ready: 
 

 
 



The Payroll Setup screen controls how the system will deal with overtime pay.  If you 
place a check mark in the Auto Split Overime box, the system will automatically move 
hours into overtime, when the total number of hours for the week exceeds the regular 
time limit.  The bulleted options beneath this check box control how the regular time 
limit is calculated: 
 Adjust Only Regular Time to Overtime: Witth this option selected, the system 
will subtract the number of Travel Time hours worked from 40.  The result is the total of 
Regular Time that must be reached before Overtime begins.  The system will switch 
Regular Time hours to Overtime when they exceeed this limit.  Travel Time hours will 
never be changed into Overtime, no matter how many Travel Time hours are worked.  
For example, if the technician has 11 hours of Travel Time on file for the week, the 
system would begin changing Regular Time into Overtime when the Regular Time total 
exceeded 29 hours. 
 Adjust Regular Time and Travel Time to Overtime: This option will cause the 
system to begin switching both Travel Time and Regular Time to Overtime, when their 
combined total exceeds 40 hours. 
 
If you leave the Auto Split Overtime box un-checked, the system will not switch any 
hours to Overtime automatically, unless they were already designated as Overtime on the 
Call Slips.  Payroll will read and display all hours exactly as they appear on the Call 
Slips.  You can manually change hours between Regular and Overtime during Payroll 
processing, no matter which option you choose here. 
 

 Use this pull-down menu to set the starting day for your 
payroll week.  This should be set to the same day you selected in QuickBooks, on the 
Edit / Preferences / Time & Expenses / Company Setup screen. 
 

III. Payroll Linking 
 
This screen is accessed by clicking the Linking tab at the top of the Payroll Setup screen.  
When you click the Linking tab, there will be a pause as Acowin requests employee data 
from QuickBooks.  The screen will then populate with a list of employees, as they appear 
in the Employee Center of QuickBooks.  The initial appearance of the Linking screen is 
pictured below. 
 



 
 
The top entry on the Linking screen is named Company Defaults.  When this entry is 
selected, the right side of the screen provides pull-down menus to select the standard 
QuickBooks payroll items for Travel Time (TT), Regular Time (RT), Overtime (OT), and 
Double Time (DT).  It is possible to link more than one Acowin pay category to the same 
payroll item in QuickBooks, as you can see from the example screen above, where Travel 
and Regular Time are both linked to a QuickBooks item called “Regular Pay,” and both 
Overtime and Double Time categories are linked to “Overtime Rate.”  Be sure to link all 
four Acowin pay categories to QuickBooks payroll items. 
 
Once the Company Defaults have been set, you can click on an employee in the list of 
names, then link the employee to their corresponding entry in QuickBooks.  Remember 
that you only need to link the technicians to QuickBooks – that is, the employees who are 
dispatched to Call Slips, applying their labor to service or Job Costing projects.  To link 
an employee to QuickBooks, place a check mark in the box named Create Time Cards 
in QuickBooks.  This enables you to pull down the Name list, and select the name of the 
matching employee entry in QuickBooks.  In the example pictured below, we have 
selected an employee named Hanby, Shane B, checked the “Create Time Cards in 
QuickBooks” box, and used the Name pull-down menu to select the matching “Shane B. 
Hamby” entry in QuickBooks. 
 



 
 
The right side of the Linking screen also includes an option called Override Company 
Defaults for Wage Codes.  If you check this option, the screen will change, allowing 
you to change the QuickBooks payroll items linked to Travel, Regular, Over, and Double 
Time for this technician.  This could be helpful for special technicians who don’t use the 
standard QuickBooks payroll items you selected as the Company Defaults. 
 
Click OK after you have linked your technicians to their QuickBooks payroll entries.  
You can revisit the Linking screen whenever you add new employees to QuickBooks and 
Acowin, to link them together.  New employees should be added to both Acowin and 
QuickBook, then joined together with the Linking screen. 
 

IV. Payroll Processing 
 
At the end of each pay week, when you are ready to process payroll, click the 
Accounting Utilities button on the Acowin Main Menu, then choose Process Payroll. 
 

 
 
The Payroll Processing screen is pictured below.  Notice how the Pay Period dates have 
been set automatically – the system looks at the current date, works back to the day you 



specified in Payroll Setup as the first day of the payroll week, and sets the dates 
accordingly.  If you want to change the starting date for the current payroll run, you can 
click the Calendar button next to the dates. 
 
You can use the Distribution Code and Tech pull-down menus to limit the results that 
appear on the Payroll Processing screen.  If you leave these pull-down menus blank, labor 
from all technicians and Distribution Codes will be pulled onto the screen.  Totals for 
each technician will still be provided. 
 
When you’re ready to begin working on payroll, click the Get List button. 
 

 
 
The screen will initially be populated with hours read directly from your Call Slips.  Each 
line specifies the technician, work date, day of the week, Call Slip number, and Site 
Name for each line of labor.  The hours worked are then divided into Travel Time (TT), 
Regular Time (RT), Over Time (OT) and Double Time (DT) columns.  You can freely 
adjust the hours in these columns, to agree with time sheets submitted by the technicians.  
Of course, if the Call Slips were filled out accurately, it should not be necessary to make 
too many adjustments.  Any hours you adjust manually on the Payroll Processing screen 
will turn green. 
 
If you checked off the option to “Allow Auto Split Overtime” in Payroll Setup, you can 
click the Adjust to Overtime button at the top of the screen, to prompt the system to 
automatically move hours worked beyond 40 into the Overtime column.  Any hours 
pushed into Overtime by the system will turn red. 



 
When the Payroll Processing screen accurately reflects the hours you wish to pay the 
technician, click the Process button at the bottom of the screen.  This creates the 
Employee Time Cards, and sets the hours to be synchronized with QuickBooks.  Clicking 
the Process button clears the screen.  If you’re processing one technician at a time, you’re 
ready to select the next technician, and click Get List to begin working on his hours. 
 

V. Synchronizing Payroll to QuickBooks 
 
Payroll hours are sent to QuickBooks by running the QB Sync process, which you can 
find on the QB Sync menu at the top of the Acowin screen.  From the QB Sync menu, 
select Synchronize.  The Synchronize program has a separate check box for Payroll 
processing.  Place a check mark in this box, then click the Synchronize button, as 
pictured below. 
 

 
 
When the QB Sync is complete, you will be able to see the hours from Acowin by pulling 
down the Employees menu in QuickBooks, and choosing Enter Time >> Use Weekly 
Time Sheet.  On the Weekly Time Sheet screen, select one of your technicians with the 
Name pull-down menu, then use the Calendar button to select any date that fell within 
the pay period you just synchronized from Acowin.  For example, if you processed 
Acowin payroll for the week of May 10 to May 16, 2009, you could select any date 
between May 10 and May 16 2009 to see the hours for the chosen technician.  Below is 
an example of Weekly Timesheet hours sent over from Acowin to QuickBooks. 
 



 
 
You may now follow the normal procedure for completing payroll in QuickBooks.  
Please refer to the QuickBooks help system, documentation, or on-line training resources 
if you need any help with the QuickBooks payroll procedure. 
 

VI. Employee Time Cards 
 
After you create payroll with the Payroll Processing screen, the hours will be stored in 
Time Card records, which can be accessed from the Acowin Employee File. 
 
Once you locate the desired employee in the Employee File, click the Time Cards button 
in the lower-left corner of the screen.  A window will appear, listing all of the weekly 
Time Cards that have been compiled for the employee. 
 



 
 
You can double-click on any of the listed Time Cards to see a full display of the 
employee’s hours for the week.  If any of these hours have not been synchronized to 
QuickBooks yet, they will be shaded green. 
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